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Why Does It Matter? 
BACKGROUND 
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Why the 
Focus on 
Control 
Premiums? 

SEC focus 

 

Equity market volatility 

 

Diversity of practice 
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A Sample  
of SEC 
Comments 

…we have read your response to comment in 
our letter dated June 30, 2009.  In future 
filings, please ensure you disclose the basis 
for why a control premium of between 35% 
and 40% of market capitalization is 
reasonable...   

…If you included a control premium in a 
goodwill impairment evaluation utilizing the 
quoted market price of your common shares, 
please tell us how you determined that 
control premium and why you believe the 
assumed premium is appropriate in your 
circumstances.  
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December 
2008 Speech 
by Robert 
Fox (SEC) 

...the amount of a control premium in excess 
of a registrant’s market capitalization can 
require a great deal of judgment.  Contrary to 
some rumors I have heard, the staff does not 
have “bright line” tests… 

…an important factor to consider is their 
recent trends in market capitalization…in 
volatile markets, and other unique 
circumstances, it may not always be 
reasonable to look at a single day’s market 
capitalization… 

…[a control premium] based on an arbitrary 
percentage determined by a “rule-of-thumb” 
would not appear to be well reasoned… 
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Equity Market Volatility 
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Diversity of 
Practice 

Consensus within the profession 
has been elusive 

- Eric Nath – BVR 1990 

- Michael Bolotsky – BVR 1991 

- M. Mark Lee – BVU 2001 

- Aswath Damodaran – 2005  
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What Are We Doing? 
OVERVIEW OF WG3 EFFORTS 
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Efforts that 
Address 
Control 
Premiums 

Appraisal Foundation Third Working Group 

- For business valuation – primarily 
impairment 

- Step transactions 

- Investment company issues 

AICPA – Impairment Task Force 

- Focus on premiums as it relates to testing for 
impairment of reporting units 

AICPA – Valuation of Privately Held 
Company Equity Securities Issued as 
Compensation 

AICPA – Portfolio Valuation Task Force 
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Considerations Different standards of value exist  
for different valuation purposes 

 
Depends on both the unit of account  
and the inputs used in the valuation 

 
Refer to the appropriate standards  

which specify the unit of account for  
each asset or liability when thinking  

about control premiums 
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Appraisal 
Foundation 
Third 
Working 
Group 

Two discussion drafts have been released; 
final exposure draft due to be released soon 

Focuses on the concept of control premiums, 
when  measuring fair value for financial 
reporting purposes. It does not address: 

- Premiums in other contexts such as tax or 
disputes 

- Discounts for lack of control 

Focus on control premiums when considering: 

- Impairment  

- Investment company holdings 

- Step transactions 

Once finalized it is expected to be accepted by 
audit firms as “best practice” 
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Appraisal 
Foundation 
Third 
Working 
Group 

Core Message: 
Ontology Matters. 
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Appraisal 
Foundation 
Third 
Working 
Group 

A control premium describes the 
relationship between two values 
– it defines neither 
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Appraisal 
Foundation 
Third 
Working 
Group 

What is a control premium? 
- A fairly controversial concept 

- Some would argue that it doesn’t really exist or 
is rare 

Some of the prerogatives of control 
include: 

- The ability to make all management decisions 

- The ability to benefit from synergies available 
through combinations with other entities 

- The ability to change the cost of capital to the 
entity by changing the capital structure  

- Reducing the cost of capital due to achieving 
greater diversification and size 
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Appraisal 
Foundation 
Third 
Working 
Group 

The monograph introduces the term 
Market Participant Acquisition Premium 
(MPAP) 

Differentiates those elements of value 
above marketable non-controlling share 
value that are appropriately included in 
the Fair Value of a controlling interest for 
financial reporting  
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Appraisal 
Foundation 
Third 
Working 
Group 

The MPAP Definition: 

- The premium that describes the price paid by a 
set of market participants in order to acquire a 
controlling interest  

- It is also the difference between (i) the price that 
would be paid by those market participants for 
the subject controlling interest (fair value) and (ii) 
the value of marketable non-controlling interests 
in the subject business (“Foundation Value”) 

- Represents the enhancement to value that 
market participants would expect to realize (and 
pay for) as a result of enhanced cash flows 
and/or reduced risk if they gain control over the 
subject business  
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Appraisal 
Foundation 
Third 
Working 
Group 

Fundamental perspective of the group: 

- Prices paid for control of entities can 
reasonably reflect the economic benefits 
the buyers expect from ownership of the 
entity 
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Appraisal 
Foundation 
Third 
Working 
Group 

Fundamental perspective of the group: 

- Quantification of economic benefits 
typically focuses on: 

+ Cash flow impacts 

- Enhanced growth, 

- Increased margins, 

- Working capital and capital expenditure 
efficiencies 

+ Reduced Risk 

- Greater size and diversification of the post-
acquisition company 

- Buyer has better access to less costly capital 

- Optimizing the financing mix of a company 
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Excursus: 
Measuring 
the MPAP 

The Working Group believes that 
measuring the MPAP on an enterprise basis 
is more consistent with the underlying 
factors influencing the premium 

 
Marketable

Non-controlling Fair Value
Enterprise Value $4,715 $6,354
Interest-Bearing Debt 1,716                 1,716           

Equity Value $2,999 $4,638

Shares Outstanding 300.0                 300.0           

Fair Value per Share $10.00 $15.46

MPAP (Equity) 54.6%

MPAP (Enterprise Value) 34.7%

21 



Appraisal 
Foundation 
Third 
Working 
Group 

Fundamental perspectives of the group 
- The market participant, a rational buyer, will pay 

no more than necessary to outbid the next most 
aggressive bidder for a given investment 
opportunity  

- Bidder interest matters: where bidder interest is 
low, the market price is less likely to reflect 
significant MPAP benefit, but where there is robust 
bidder interest, the price may reflect a higher 
portion of the available benefits of the MPAP   

- In no case is a market participant willing to pay an 
amount that exceeds the value of the maximum 
cash flows that can be generated through the 
business combination 

- In addition, control is often expressed on a 
spectrum and can also be applicable when an 
entity has significant influence over another entity 
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Appraisal 
Foundation 
Third 
Working 
Group 

Fundamental perspective of the group: 

- An entity might have a greater value after an 
acquisition than it has under current 
management 

- The Working Group also believes that premiums 
for control may not always be warranted 

- If current management is already operating in a 
manner that is similar to the value that would 
reasonably be achieved after an acquisition, 
then the value before and after acquisition would 
reasonably be similar 
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Appraisal 
Foundation 
Third 
Working 
Group 

Fundamental perspective of the group: 

- The level of analysis should reflect the 
importance of the premium to the analysis 

- A benchmark control premium resulting from the 
analysis of comparable transactions typically is a 
basic approach to understanding value 

- Detailed analysis of the enhanced cash flows 
attributable to control provides the best form of 
support for control premiums 
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Appraisal 
Foundation 
Third 
Working 
Group 

Examples of items to consider when studying 
MPAP: 

- Who are the market participants (strategic, 
financial, etc.) 

- Size of market participants vis-à-vis target 

- Stage in life cycle of subject entity 

- State of industry acquisition activity 

- Growth rate of peer companies 

- Margins of peer companies 

- Balance of information 

- Capital structure of the target company 

- Perceived quality of management 

- Contingent consideration 

- Regulatory factors  
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How Can We Help? 
EXAMPLE 
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Example: 
Initial 
Evaluation to 
Determine 
Appropriate 
Level of Rigor 
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Calculate 
Minimum 

“Passing” MPAP 

If Significant => 
Detailed Analysis 

If Not Significant => 
Summary Analysis 
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Example: 
Scenario 1 
(Detailed 
Analysis) 
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Example: 
Implied 
“Passing” 
Multiples 
Compared to 
Guideline 
Public 
Companies 
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Example: 
Economic 
Factors 

Comparison of assumptions reveals three 
primary factors influencing MPAP: 

- Enhance revenue due to larger distribution 
networks of market participants 

- No meaningful cost savings identified 

- Lower cost of capital due to financing 
advantages of market participants 
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Foundation Fair
Value Value

Expected 5-yr CAGR (Revenue) 6.1% 8.0%
Gross Profit Margin 60.0% 60.0%
Operating Expenses:

Research & Development 5.0% 5.0%
Distribution Expenses 13.5% 13.5%
Selling Expenses 17.5% 17.5%
Other General & Administrative 7.0% 7.0%

EBITDA Margin 17.0% 17.0%
Weighted Average Cost of Capital 10.5% 10.0%

Total Invested Capital $657 $740
TIC / Trailing Revenue 1.1x 1.2x
TIC / Trailing EBITDA 7.1x 8.0x

MPAP Implied by Cash Flow Analysis 12.6%



Example: 
Assessing 
Revenue 
Synergies 

How do the assumed market participant growth 
rates compare to guideline companies? 

Factors that might be particularly relevant for 
revenue considerations 

- Who are the market participants (strategic, financial, etc.) 

- Size of market participants vis-à-vis target 

- Stage in life cycle of subject entity 

- State of industry acquisition activity 

- Growth rate of peer companies 

- Margins of peer companies 

- Balance of information 

- Capital structure of the target company 

- Perceived quality of management 

- Contingent consideration 

- Regulatory factors  
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Example: 
Assessing 
Margin 
Enhancement 

Going back to the factors discussed previously, 
items that might be particularly relevant for 
margin considerations 

- Who are the market participants (strategic, financial, etc.) 

- Size of market participants vis-à-vis target 

- Stage in life cycle of subject entity 

- State of industry acquisition activity 

- Growth rate of peer companies 

- Margins of peer companies 

- Balance of information 

- Capital structure of the target company 

- Perceived quality of management 

- Contingent consideration 

- Regulatory factors  
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Example: 
Assessing  
Cost of Capital 
Effects 

Going back to the factors discussed previously, 
items that might be particularly relevant for cost 
of capital effects 

- Who are the market participants (strategic, financial, etc.) 

- Size of market participants vis-à-vis target 

- Stage in life cycle of subject entity 

- State of industry acquisition activity 

- Growth rate of peer companies 

- Margins of peer companies 

- Balance of information 

- Capital structure of the target company 

- Perceived quality of management 

- Contingent consideration 

- Regulatory factors  
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Example: Assessing Overall Reasonableness 

Does comparison of the implied multiples to the guideline public 
companies reveal a coherent narrative? 
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Guideline Public Company Data
Market

Projected Est. 5-Yr Value
LTM LTM EBITDA Revenue (Invested MVIC / MVIC /

Revenue EBITDA Margin Growth Capital) Revenue EBITDA
Company A $29,000 $5,220 18.0% 6.0% $31,320 1.08x 6.0x
Company B $5,100 $893 17.5% 10.0% $6,248 1.23x 7.0x
Company C $13,200 $2,508 19.0% 7.2% $13,794 1.05x 5.5x
Company D $2,400 $408 17.0% 5.0% $2,040 0.85x 5.0x
Company E $9,000 $1,170 13.0% -2.0% $5,265 0.59x 4.5x

MEDIAN $9,000 17.5% 6.0% 1.05x 5.5x
AVERAGE $11,740 16.9% 5.2% 0.96x 5.6x

Subject Company 17.0% 8.0% 1.10x 6.5x



Example: Assessing Overall Reasonableness 

Does comparison of the implied multiples to comparable 
transactions make sense? 
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Guideline Transaction Data
Est. 5-Yr Transaction

LTM LTM EBITDA Revenue Value MVIC / MVIC /
Revenue EBITDA Margin Growth (TIC) Revenue EBITDA

Company F $4,500 $788 17.5% 4.0% $5,513 1.23x 7.0x
Company G $7,800 $1,248 16.0% 8.0% $9,360 1.20x 7.5x
Company H $9,000 $1,170 13.0% 5.0% $7,020 0.78x 6.0x

MEDIAN $7,800 16.0% 5.0% 1.20x 7.0x
AVERAGE $7,100 15.5% 5.7% 1.07x 6.8x

Subject Company 17.0% 8.0% 1.10x 6.5x



Example: Assessing Overall Reasonableness 

Is comparison to observed control premiums compelling? 
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Guideline Control Premiums
Observed Observed

Transaction Transaction Interest Transaction Unaffected Control Control
Price Per Shares Value Bearing Value Price Per Premium Premium

Share Outstanding (Equity) Debt (TIC) Share (Equity) (TIC)
Company F $36.50 55.1 $2,013 3,500 $5,513 $28.00 30.4% 9.3%
Company G $61.00 153.4 $9,360 0 $9,360 $45.00 35.6% 35.6%
Company H $25.00 220.8 $5,520 1,500 $7,020 $15.75 58.7% 41.0%

MEDIAN 35.6% 35.6%
AVERAGE 41.5% 28.6%



Is Control 
Premium 
Data 
Valuable? 

Yes… 

- Provides a composite view of the 
control benefits perceived (and paid 
for) by acquirers 

- Helps establish the reasonableness of 
cash flow benefits assumed (or 
implied) by fair value measurement 

… but the data cannot be relied on blindly 

- Relative financial performance 

- Implied multiples 
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Example: 
Initial 
Evaluation to 
Determine 
Appropriate 
Level of Rigor 
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Calculate 
Minimum 

“Passing” MPAP 

If Significant => 
Detailed Analysis 

If Not Significant => 
Summary Analysis 
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It is important to thoroughly check the presentation to ensure that no further formatting is needed.



Example: 
Scenario 2 
(Summary 
Analysis) 
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Presenter
Presentation Notes
It is possible to apply this template to exiting presentations.
Have the latest presentation template open
Click on the View tab and select Normal 
Delete all unwanted slides
Click on the Insert tab from the menu bar and select Slides from Files
Click on Browse. Navigate to the presentation you wish to update with the new template. Highlight the presentation and click Open 
Wait for the slides from the presentation to load and click on Insert All. Then click Close
Check the inserted slides to ensure that the most appropriate master slide has been used on each slide 
To change the master applied to a slide select the slide you wish to apply a different master to then click on the Format tab from the menu bar and select Slide Design
From the Used in This Presentation section choose the master you wish to apply to the slide and hover over it to reveal a drop-down arrow. Click on the arrow and select Apply to Selected Slides
It is important to thoroughly check the presentation to ensure that no further formatting is needed.
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Implied 
“Passing” 
Multiples 
Compared to 
Guideline 
Public 
Companies 
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Presentation Notes
It is possible to apply this template to exiting presentations.
Have the latest presentation template open
Click on the View tab and select Normal 
Delete all unwanted slides
Click on the Insert tab from the menu bar and select Slides from Files
Click on Browse. Navigate to the presentation you wish to update with the new template. Highlight the presentation and click Open 
Wait for the slides from the presentation to load and click on Insert All. Then click Close
Check the inserted slides to ensure that the most appropriate master slide has been used on each slide 
To change the master applied to a slide select the slide you wish to apply a different master to then click on the Format tab from the menu bar and select Slide Design
From the Used in This Presentation section choose the master you wish to apply to the slide and hover over it to reveal a drop-down arrow. Click on the arrow and select Apply to Selected Slides
It is important to thoroughly check the presentation to ensure that no further formatting is needed.



Example: 
Summary 
Analysis 

+ Income Approach:  Consider 
same synergies, but not 
necessary to make specific 
quantification 

+ Market Approach:  Same 
analysis prior to application of 
MPAP 

+ MPAP Estimation: Preliminary 
estimate made with primary 
reference to guideline 
transaction control premium 
information likely sufficient 



What Do You Think? 
Q&A / DISCUSSION 
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Travis frequently speaks on fair value 
accounting topics across the U.S. He is a 
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